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Download: Click here to download the TRNSYS18 Demo (230MB)
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1.2.1 TRNSYS End-User License ({#RFEICRE)
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1.2.2 Select components to install (4 > X b—JLF 5V R—3 > bDEIR)
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Next] R¥ %27 Vv 7 LET,
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Installer
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TIPS Windows A==—{Z, [TRNSYS | W) T FUr— a3 0E8 A, @O TRNSYS OE/EITV O
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This is a demo-version - restrictions apply.
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File>New
Th, BROT BT 2/ bI A R BMERTEET,
VLR New R AU WA T, Ama— 33—
View>Toolbar>Common
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o File Edit View Direct Access Assembly Calculate Tools Window ? - x
Ob=zE& B = N1
b = *
{1 Controllers
M 4271 Electrical
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e 3 Has
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4271 Loads and Stuctures
{1 Obsolete
4271 Output
o L1 Physical Phenomena
‘D - Solar Thermal Collectors
{21 Themmal Storage
& - Utiliy
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A
v
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Ready NUM

4 T4 RTYA XD

TIPS KEBEFIR L AT L&A+ 584 . "Empty TRNSYS Project” TiZ7¢<. "Solar hot water system” %
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EEARICH DY Y —FRRDY 4 FUT, b 6% HIZH %”Solar Thermal Collectors” 7 /L & D /i
WZodHEI V7T TROTOOV 77 4V EIREMEZERSNET, S HIZ B2 D 52 H D Quadratic
Efficiency Collectors” 7 # /XD [+] #27 Vv 7325, TFTEOE DOV T 7 3L EZNFREINET, EHIT,
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TIPS BERENTZVV—FRREALIZWEXIT, AV X DD [ 20V 7 LET,
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I DT —HR—ATT, T R — kU R R BERER], T T LRI T I ENTTEE
T T ERTHRERE R LA RN — R MRS T ET

TIPS 72~ Direct Access VAL RUDA LD [X] #2Vv7 L, U4 RUBEALLN TLEST25E T,
%;Jg/\‘*—@
View > Toolbar > Direct Access

WCF =7 Hl FRRENET,

%, Simulation Studio - [DEM O VERSIO N - Project.tpf] - m] X

<G File Edit View DirectAccess Assembly Calculate Tools Window 7 - 8 x

DEEd =2 &k 7

{1 Contallers

{21 Elechical

{1 Ground Coupling
- HVAC

-1 Hydiogen Systems
-1 Hydronics

-{Z0 Loads and Structures

BLrEs &

{1 Obsolete

L1 Dutput

{1 Physical Phenomena
5142 Solar Themal Collectors
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423 Quadratic Efficiency Collectar

{1 2nd-Order Incidence dngle Moflifiers
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{1 Cover and Absorber Properties| >
-] Mordfers=f{Incidence Angle] xIL 9 ﬁ
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KSvd &rkoyr - e

{1 JMEaretical Flat-Plate Collector
Thermosyphon Collectar with Integlal Starage

Thermal Starage

i & -3 CPC Collector =
cl {1l Evacuated Tube Collectar

o Typela -1 Pertormance Map Collsctor

A

]

A -
{1 Utility
A {21 "eather Data Reading and Processing
ﬁ v
< >
Ready NUM
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TIPS TRNSYS TI3afMic, ar R —x hofEiEE Type F B THELTEBY, ZHUdy—Aa—RickBi)5
YT —F DXy EFFETT, FlZ1E, Typel i+ Quadratic Efficiency Collectors (2 kERRATET L
(LENTEEER) IR LTS, Typel OHEITHIK a REDT LT 7y hE, Typel O THELITERIN A e/ T
—REEN, Direct Access DY 7 7 HNF LIS TR EW H THDHIEEERL TWET, #il21X Typela
X, B O AR A RRE O E T —RIZE VT, No incident Angle Modification (3 J&-89%) 3% &% 40 Typel

<7,

2.4 STEDETT

FEBPTTN, KLY Iab—varz2ELETAHET, TRNSYS ORWEE LT, fEREEE L2
THEHRLRVWEBIZE, 774V FORETHALLDENRAN SN TNDSTD, arFR—Ry M ERE LS
TR TEVH2PELEDL] ZeNTEET,

B AT HI12iE, Simulation Studio D E I AGHIHEZAE AT — L X—(Z8H 5"Run” R & Rrryy
7 LET, fHRPIEIREDOT 0 T LAN=—DHLT 4 RURRYy T T v 7L, SHEPTHLZLERLET,
HENETTLE. AFORFZ 2V Continue”IZEDLDT, Za /7 Vv 7 LTHERRIRV AV RUEALE
R
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Calculate >Run simulation
Th, 2, F— R —FD F8 RZ L ThatHEEF(TTEET,

TRNEXE: C¥TRNSYS18demo¥MyProjects¥Project¥ DEMOVERSIO ..

Calculations completed.
Elapsedtime = 0 sec

1501 TRNETE Releaze 15.00.0013

6 TRNSYS OEUER) 723 E il (FH5R5e TH)

FIEHEMROM N FEEHREL TORWZD, FHERREZMGET 22 LI TEEEAN, T bbb,
TRNSYS OFHBETZ U PUABE, v Ialb—varMTR5 2 LR TEE L, b L, AENETTE R
WAL, TRNSYS BIELL A VA =L TETWRNWABEERSV ET, A VANV TANEET 7+
NV EOREIZLT (AN FZdBEET). BEA A R— L LTHTIEEN,
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FTHILZWARBESIUE A, ZFDIC, 7TaV = MR FEL TRLZEEBEID LET,
Simulation Studio D A== —/3—715

File > Save as... (4 HiZAHT THRT)
27Uy 7 LTIRIFT D &, 57 40 kT, C:¥TRNSYS18Demo¥MyProjects (7272 L. fALRDB AL,
C:¥TRNSYS18¥MyProjects) 7+ NV A o7 ay =/ MOMRTFCEEF, TRNSYS o7 uev=/ b7 74
NOPEIETIX tpf (Trnsys Project File) T,

LipL, @FII7Tey=7 MIBEET 7 7 A0 (ROENT 7 A R0, AEE LT —F 77 A N7 E)
DEEFEL, $7n vz PHEEIER SN TWE 9O T, MyProjects 7 4+ VI EfHHEIZ T A A7 0
F9. HIiZ. MyProjects 7 ANV FXDHIZT Y=y hTEOMEM T NV FEIER L, TOHIRETDH L 1T
DMTEL X9,

T, “Test” 74 NZEFHLIAEHK L, TOHFIT Test.tpf” & L TRFEL T EE W,

TIPS TRNSYS Tid, /SADD, AL T 7 A VHICEDLET, HABECEMG G RAA—R T —UEH
TEEHA BRATTEET N, HREEFITTEETA), EIDRRCEBL SN, [FARIhy 7 R0 R o
Ab 728 Windows  EO o —PEHEGEIC T 0V 2/ MARFEL CLEIE, BT TEET28, FLodEE
FATTEEE A,

F A THoTh, TV M RBEBA T ANR— 2 ANDT LIRS T2IFI WA T, (T K80 &1
TG AT, A= 2DRDVIET _7 (T U F —3—=) 2 HHF T,

2.6 EEBD/INTA—REERTE

TuTel N4y RUICRE SN Typela’ DT A 2L %X TNT Vw7 TDHE/NINT 42 RURKRY
TT T LET, WTROIUR—RX L N ThH, TA AV EX TNV Y v THE ZOREREDTZDDT 4
YRUDBSEL ERY | o X7 (Typela Tix 4 2) TOLK OO ANHAZ V=7 BEID B2 Hd ko1
o TWET,

WE., LITRE - R L7 T bRWANIEE 7 — 713 Parameter (/X7 A —%) *&”Input (1 7
v ) "O_>7TY, FAIE LT.” Parameter” |3, I =2l —valEFBUTEFRINDZ LDV, HEERE
HAORMEZREST HEE T, Bl ERREAL NS LES, —75.  Input” 1F, ¥ I=lb—
T a VOREMZLICE LT (DFEVFALRAT T T L), AL LB SEDHZ L DOTEHHETY, #
ZIE, BRSSP RENS ZAUCHY LEY, Input iX, Z{bSEFEDMHELETHZ b TEET,

TIPS Parameter & Input THRIRIAILDEH B KIL, JRAIEL TEE - S TEER A, #1213, Parameter [ZA
STWAEIIRAFEE ., Input BRICEZAZ LT TEFHEA (V—Aa—ROEFLHI L SANVERLETT),

T 2T, TEBARIT IR 3.6kd/kgK DARERIK & VT2, BB 2mYk O SEARTIERGR A . 2 MESITHED
Bl T52LICLET, £OH, Parameter ® 1~3 FEZT 7 4L MENS, UFDOXHICEELET, 4%
HOBED T X —=%21%, Typela DT 74/ MazZOFFEFH L ELET,
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Number Name Value  Unit

1 Number in series (EL¥I#%%) 2 -
2 Collector Area (S ER HIFH) 4.0 mn2
3 Fluid Specific heat (2 BABE R D LL2R) 3.6 kJ/kg.K
4 Efficiency mode ((£EVEFED A J)E—N) 1 -
(DEMOVERSION - Testtpf) Typela - x
Input Output Comment
= Mame ~, Value Unit More Macro
1 & Mumber in series 2 - More ..
i 2 = Collector area 4 md are .
3 gp[Flud specific heat 36 klike k. tore .
4 & Efficiency mode 1 - More ...
[ & Tested flow rate [Foo ke shrmee aore .
[ & Intercept eficiency o7 - Mare ...

7 Typela((EEAER) D/ A— Kk TE

TIPS Unit (A7) 2E 3 5&, AJ1iE A0 Value () 23 HBHRAH SN SO THEEBLETT, B E2E 2720
B, JElC Unit 27 V2D CAETEL TG, Value A HLET,

TIPS 4 % H® Efficiency Mode” D XH12, FaRsiz Name (4 BT 721 TIEE R D LM HIROE A I,
Unit DA EDIZH D More” RE L a2V 7§58 FEMRRAR Ry 77 v P RRENFET,
SOIZEELWILIARN MR AT, A2 — N—OAMIZHAT 2 13D Helpl 220y 7358 v~ =a T Wik
IRENDDT, ¥ 4 T Component Mathematical Reference 728 D% 45 &ML £,

TIPS Typela ¢ Parameter Efi% NIZAZm—/L 354 9 & HIZ Optical Model EWHIHHB3HDET 23,
Value (31 L7 > TI L AT UM, 2—FIXZOEEE T TERII2>TWET, Zhd, Typel D7a” L THEES

NTEHET—ROEBITHEELET,

ZOY 4 RO, TOK) LW ol DWERY V0, [Fy L] EVocBOIHLAY v idd ) &
Hho T4V ETEBLS LA EOROIXIEZ U v 7T 50, F—K— Fo[EsdlF—a LET, oM
(e e A LTS G2 OB S S, B LI CX A D CRE LTS S, Z0Fh. 2K
XY FOREETNTT 7 40 MREBICE L7ZWEE T Bl 2 ANET LD b Hia s R—x FEHIBRL,
Direct Access 72> 5 CHILE L7228 771E 2 A H T,
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27 ERBAVKR—R MDAV Ty FEERTE

Parameter (25 &#HiX, Input ZEL TWEE T, Typela X 727 U v 7 LTRRINDFHEREDT-
HOT 4 Ry (RN BHENEZEFICR>T0D ERBVWETOT L ECHD Input’ 0¥ 7% 27 U v 7 LET,
ZOWEEA B, Typela & Input OHIZ 4 SOBREEFRZFF> TWND I ENDNY £,

Input O EE T H Parameter DR EMME &R U L 9 2RICHR > TWETR, KEREWE LT, Input ©
Value If, I =2b—va v OHHfE] THLEWI ARHVET, ZL, oa U R—x MEMGEL
EORBREICR s TOARWVIHBICOWTE, I ab—ya VO], #ICPESRA S ET, +72b5, Input
25 Parameter &R U & 912, BEEME LTHDOND LD Z L TT,

TIPS 7 Z 1AL, Name f23 T R CHWFIR > TOVET, ZIUIMMOa L R— R Mnbizd EHREITR
STUVRNZEZERLET, oz R— R MTENR > TODIE B IXBWFITRDET,

ARIOFEETIT.OEFET1IFL 2FTECHEE L.3FLA4FTEIRIILEEZBET 2065252 LI LFET,
FIEERT A —F ORT CHEARAEELEFTE LD T ST 2B RICEE T 57290, 2 % H D Value & 200
WCEFLET,

Number Name Value  Unit
1 Inlet temperature (£ A R ) 20.0 C
2 Inlet flowrate (FE ZABE{A T ) 200 kg/hr
3 Ambient temperature (4 <R E) 10.0 C
4 Incident radiation (42 £\t D AST H 51 &) 0. kd/hr.m"2
(DEMOVERSION - Test.tpf) Typela - X
Paramutput Comment
= S ureName |'_ Value Unit More Macro
g o =y o
3| g[FmERnt temperature T E More ..
T ot 5 T T—

8 Typela((£ER) DAL 7 bk iE M

E

Ka

28 EEK[EZT—ADAVKR—R FEEE -

AT, BRERANRIRER EORRT —F 2 a b —ya VICHIAT A 0ciE, EERGT — X & A0
L=k HUINT —FETFANT 7 ANANLFHAL T —AD B BH Y £9, TRNSYS TiEWd
NOFESBARETT A, T Z T HIZ TRNSYS IR S LTV DIEERR T — 2 b v aRff+ 528 &
LET, TEMCHAAREZR B ARENOEERRT —2 & LTE, HRET A ARET—4% (KR &,
[Meteonorm 5% 7 —4 (KBR) ) ® 2 o03HV ., ZZ T ZMALET, 28, KT, Meteonorm
OMRF DL B OT — X NEENTVET,
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LRI L X L[FERIC, Direct Access TUUTD 7 4L Z % BB L, Type99-AMeDAS & =2 i R—x > h &,
TV bU4r RUICREL T ES0,
Weather Data Reading and Processing > Standard Format > Japan

%, Simulation Studio - [DEM OVERS IO N - Testtpf] - m] *

e

ey = g ek 7

AL s

N ol

o o= NN M2
RSvd &ray” i T
A -] Typical Meteorological Year Files [Thr)
R (23 User Format -
v
<€ >
Ready NUM

File Edit View DirectAccess Assembly Calculate Tools Window 7 - 8 %

{1 Controllers
{7 Electrical
3 Giround Coupling
1 HvaC
{1 Hydiogen Systems
{1 Hydionics
{1 Loads and Stuctures
{71 Obsolete
O g Output
* Physical Phenomena
@ ’ 1 Solar Themal Collators
{1 Themal Storage:
£ Uity
=-{] ‘weather Data Reading and Processing ==
423 Standard Fomat
- Energy+ Weather Files (EFW)
German TRY 2004
German TRY 2010

Gemman TRY 2017 Egﬁéhf:

{3 Intemational Weather for Energy Cal Llation
424 Japan i By

i ety TupeS%AMeDAS 7*)'/9 gi
eonorm Files (THM2)

Type??-AMeDAS Typela

9 Type99 (JLIRET AX A5G G 7 —4# =L 7R— % 1) % Direct Access 2> HRELE

Type99 OT7 A 2L X TNT U w7 LT, FEREDTZODO T 4 FUEHEET, RIA—FEFEELE
Hh, Input’# 7% 27 ) w7 LT, A7y MREMEZHE £, Type9d9 (2i%, HITHIRT A ¥ 2K ELT —
% % TRNSYS (2t 280721 TER L ARBDOHAL - HRAZ AT 20O HHEZFHE LT DN i
LTWET, ZOHEETIE, £EROENEIZART 2 A FHESNLE RO T,

FFNEA e [ &
R 30°

CUTHE CTRER RERFONDID AT Y MEBE T 2 &L 3 BLLU FOITHRELES, FAAIE,

IR THIITEM D 0° T ML MEIZIEOMAELL TERSNTWET, "More” RZ -z ffid-L, 2D
FORAED NN TIEDFFMPTRSNET,

Number Name Value  Unit

1 Ground reflectance (M1 i D7 /LK) 0.2 -

2 Slope of surface (G5 %42 i DA} A4 FL) 30 degrees
3 Azimuth of surface GHHEXFR DS NLAEE) 0 degrees

13



(DEMOVERSION - Test.tpf) Type®e-AMeDAS - X

Paramtput Derivative Special Cards External Files Comment

s L Mame Value Unit More Macro
1 Ground reflactance 0z =
More ... ol
o
i 2 & Slope of surface / 20 \ degraes [
3 s Azimuth of surface on / degrees Mare ..

= 10 Type99(?ﬁ%ﬁT?‘&XﬂgﬁT*Wﬂ:‘/T_’?/H034/7/%%& [ A

TIPS EHERGT —# T3, EHENFTIANT — & HAZ AT, Direct Access 75
Utility > Data Readers > Generic Data Files
DH D Type9 Z{HE5 T3,

TIPS HUATIEEHED A 4 B4R 352 R — R M, Direct Access DH D

Physical Phenomena > Radiation Processor
25, Typel6 T, HilziE. Type9 AW THAZAT K FEHE K B &%, Typele THEEE H K &I
BT 5, LVOZENRTEET,

TIPS JEBET AZ ARG T — 5 (W) DT 7 AN ~D/ A, FERET 4 RY (K] 10) DN 6 FEH DT
ThbD. "External Files” TR ESNTWET, "External Files(SME 7 7AV) "2 715, KRBT — 2O enbiit:
T —H72E TRNSYS IZith o7 AN e SHEBRE M T 27 7 ANV EDOW S EE L TNET,

29 [ET—HADY VY EERE

BT, LI ERRIT LT, Typela (FEEER) @ Inputl & & 2 FIZ, Type99 (K47 —#) @ Output 15,
ASRE L EREHO AR EEZZTETREL LET. hix [V 752135 L0 ET,

Output £ 1T HFA vV R—F L "RV I 2l —2 a3 VIZBWTHE LEEREEZHITA 4 v 2 —T = — A TY,
Parameter <° Input & [A#EIZ, Output & 2 R —F > T EICREHEBAHN R E > TWET, ZHIF. K707
Output” # 7% 7 Vv /7 FTH5Z L THBETEETN, Vo I7ZELLEITNU 4 RUTHIETELDT, &
EVRLZEITHY EHA,

Z AU TIX, ation Studio DB AN DY — /L N—IZ&H % | "Link” 7R # ‘/Jﬂff? Vw7 LET, Kt T, Type99
DT A arDFLNIHRA U ZEHH>TL DL, Type99 ORFEFHIZ 8 DR ETIIHBD/NEINWIBRFRRINET
DT, EZTHLEWDT, OEDORNE—E IV v 7 LET, THEEINLRNERBMAE, KA &Iz
SEPWTEIZ DT, KA X% Typela DT A 2 DU £ TR TW&E, Typela OFEFHOFRALD EZNT,
bO—EZVy 7 LET (BB, HAZY 7357000 0 FUNRHE ET25, M 11 ORELHR L
VDT, WolzAl EOFWIX]%E 27 U v 7 LTHETLSZEW), 2T Type99 7° 5 Typela ~D U > 7 (1%
WARERE) NTEFELL,

14



o
9 52
Type99-AMeDAS Typela

11 Type99 75 Typela ~DV 7 MRIESITIREE CH H IRV )

TIPS oY= NEEDOL ATV M REIZ LIoN &R E | MR SO A | O EDOFUEE LN L
BHVET, ZOIRGEIL. WEERBS>TODEREZY /L, FLarR—R T A2 OERIRORNETRT
T FTHIET YRR BIENTEET, T, AR =R RT A3 BIEL, TV ERBIRUTIREE TR I v /&
Fay 7 $ 527 nY 2V N4 Ry OAEE OSBRI B TEET,

FTIFEHLIEEHBZ Y 795720, V4 FUZBAEELEL X 9, Simulation Studio O i A%k D —
A= D, "Select’ B2y B ar 1) vy L. 550T Type99 7> & Typela (ZHUT=FWERHA (V7)) %
ZTNT Vw7 LET, ERUNFE/{RZZTETM (Typed9 @ Output), HHIMFERZE S Ml (Typela @
Input) T9, 2R =3 MNALIZV 7 &21T->ThH, ZTNENOT T T v hoA Ty NI SAUHD
OT HEMICENE ENEBRSOPEIIR L TIR Y F/ A ET MO U A SO EBICH S Ambient
Temperature T—E 27 U v 7 L, ARDOY X FD=E:H?® Ambient Temperature Tb 5 —E 7 U v 7 LET,
CHTHKIED Y 7 33672 &i272 0 £9, [ARkIC, ZM0 Total radiation on tilted surface & . £i{l
@ Incident radiation #2 U » 7 LC, EEHARED Y 7 Zid-> T ZE0,

Uy BNESNEHEOXTAE, 00 ERICEDY £7, /2, Type M0V 7 (¥ 10) ORAMIL, &
HBOEARHKT, =2 THLI 7 BELNTHIUEEN S RICEDY £7,

RENKEDST-L, V4V RUAED[X]IE 7Y 7 LT V7R EY 4> RUZALET,

TIPS RiEx CHEHHBMOUL 7% 1EoTLEST-341E. “Select Mode” R B &2y L-Chs, HH B
IDBNEREBIRL, T4 RTDLECH LRV XRZ L K sy 7 (£33 — R —FD[Delete] R 2 47
T)F52LT, YOV A BIRTEET, [CHFIRZ T, ZOY L Ry 0T RTOEBE MY 2%
HIBRL T,

15



Classic | Table ak Cancel

[ Select variable filter : | All ~ @123 Oaz
el A
L_*“ &
Ambient temperatur Inlet temperature 200

pod Eelative humidity Inlet flowrate 200
s.} Wind speed Ambient temperature 10.0

Wind direction Incident radiation 0.
Atmosphric radiation
Howrly precipitation

Sunshine duration

Absolute humidity

Extraterrestrial radiation on horizontal
Solar zenith angle

Solar azimuth angle

Total radiation on horizontal

Beam radiation on hortonzal

Sky diffuse radiation on horizontal
Ground reflected diffuse radiation on horizontal
Angle of incidence on horizontal surface
Slope of horizontal surface

Total radiation on tilted surface

Beam radiation on tilted surface
Sky diffuse radiation on tilted surface v

12 Type99 75 Typela ~DIH H HU 723 I bR AE

210 SHEERHB AR VR—R 2V FOBREE ) VI D

L e
X JE

on

AR RAHGET 2 72DIE, ATELOM I a v A= FEHWDRERH Y £3, 22T, V7 A¥A
AIZHF CHBETE, 2227 XA N7 7 A M H TE 5, Typebde Z iV E7, Direct Access DEL T D7
AN E BB L, Type6bc 27 m =7 b7 7 AV EICELE L TL 72 &0,

Output > Online Plotter > Online Plotter With File > No Units

%, Simulation Studio - [DEMOVERSIQON - Test.tpf] - m] X
°C" File Edit View Direct Access Assembly Calculate Tools Window 7 - 8 X
DEEE & B 7 Sk ? L A= | mMel 2 &S
A x
B {1 Cortrollers
™ -3 Electrical
a E Giround Coupling
HvAC
&%) {21 Hydrogen Systems
{1 Hydronics

x® {1 Loads and Stuctures

i ~{ Obsolete

: ‘D o o o =23 Output

L [N ' w0 E-23 Online Platter

L
F ] o .ﬁg ! © 53 Oriine Ploller with Fils
=) Typedd-AMeDAS Typela Typedic [ =R = e
o o : %, TypefSe

of” 3 TRYBYS-Supplied Units

A {3 Wer-Supplied Units

{0 Opitfie Plotter \without File
Eyefeaiator
Printer
{21 Scope
Simulation Surarmary
-] TRMSYS Plugin for SketchUp Printer
{1 Physical Phenomena
{1 Solar Thermal Collectors

o -2 Thermal Storage
{1 Utiity
/ﬁ 42 weather Data Reading and Processing
A
v
< >
Ready NUM

13 Type65¢c (17 7 ANAt AL T4 Ty X —) ZRlE LT R g
16



ZITUE, A MR (Typela @ Output O 1 35) DA% /)T 5ZLICLET, Type99 775 Typela (2
VI EIFIoTEEEFRILLNIC, Typelan s Typebsc ~2 L R—RME DV 7130, HEIF RSNDHHEE VY
JEEDTU AR T, Typela @ Output ([Z&H% Outlet temperature 7 5, Type65c @ Input @ Left axis
Variables-1 ~VU> 7 %13>T FE0,

o o

Type99-AMeDAS Typela Type65c

14 Typela 75 Type65c ~D L R—F U ME DOV 7 AR F STk e

BT (DEMOWVERSION - Test.tpf) Typela -> Type6sc O >
Classic  Table

@ Select varizble fiter : | Al v| @123 Oaz
4 N

Outlet tempera eft axis varable-1 Ctlet

4 Outlet flowrate Left axis varable-2 label
Useful enetgy gain Bight awis varable-1 Useful
Right axis variable-2

%4

15 Typela 75 Type65c ~DIHH DY 7 3 id b ki

TIPS TXARTZ 7 AN DHDH %S 5IZ1L, Direct Access D,
Output > Printer > Unformatted > No Units
(2D, Type25c ZfHiH EH] T,

2.11 FHERE - BTHZOETE

Simulation Studio ¢ M /2 # (2 HEZ W A 72 — AN — |28 D . "Settings” R4 v 8%/ ) v+ 5
L. "Settings” V4 U FUDBBREET, 2OV RUTIX, 4202 T7hRHY, 7ud=r MEEICEAT LS
FIERFHAEHLET, ZOHTH oL BEERDIE, "Basic Settings”# 71ZH 5, 3 DDHHE,

+ Simulation start time (3 = L' —3 3 > OBRLEIEAL])

+ Simulation stop time (¥ = L' — 3 O TEEX)

+ Simulation time step (I 2L —arDH A AAT v )

D 3OTT,

17



T 1IHIBA OO SER1IH2A0OMETO—ADY I alb— g 2fTWET, 14 52T v 7
1 & LES, U Eo#iEL., f12H D Calendar DEEMMNASLUTO L IITAS LT EE,

Settings *

Advanced Settings  Project  Component Order

, Simulation start time Calendar

More...

, Simulation stop time

24 |hr -

More...

- - h

Simulation time step

hr ~ More...

Fovtll AT

16 Settings 7% i [

RENTTLEDL, OKIRZ %227 v 7 LT 4 FyEALET, [y renba lolxXltu s R
VEHUEEAR., ZFEEASNAEEAOT, BELTLIEE N,

TIPS TRNSYS TiE, 1 A L HO 0 RFET0 B LT, ZIMHORARRER T H IF - FFZ 2R L £ 97, FRREA
EEEETDOILLATRE T, ZO%H A, X 16 A/ Sumilation start time, Simulation stop time O TE H ~
BEHEEE AL TTFE,

2H1ADO0RET 744K, 3 H 1 HD 0 MR 1416 B CT9. 1 H 1 A 0 Kb 1M OFHEEITIE AT, B
BRIREZIAY O IREC, #& T IREZ1 23 8760 R/ ET,

TIPS 3Rzl —yal DI ALAT L, HIDTFIUEENE VIR D TIEHVER A, BB T — 4Rl EimA It
e BirIA BT —H R, S Ral—ab Z A BART v T OEEEIR> TOBRERHY ET, filziX, 1
BERIEIRR O R G T — o A0 bIE FALAT YT H NIV EL (2 B2 E) I TEEEAL, 55112720
TRUNHIRGE (45 372 8) IZH TEEE A,

Hi>H T, TRNSYS Wi CTid, BT X ThZEB BN TS0, FHEBEIZXALAT 7 O BALE Tmin)
RMs)IZTHZEITBEO TEEEA, FIZIE, FALAT> 7% 6min(=0.1hr) ELI-3HA 1R R HI OF
FATEET 2, 1min(=0.1666666- - -hr) Tid, IOMREDFETTT —DJRRNIRHILENHVET,

18



212 HEDOETLERDOMHER

RET —Z g ribd FRGNPOH T 2BEDIRE AN ISV Iab—varymay=7 FREHRL
FL, PNCA LI X LFEERIZ, "Run”%2 27 U v 27 LT, YIal—rarzEbdThET, S 7
= A=y a VTEAHNRED 7 7RFoRENDIET T, FHE& T 9% &7Calculation Completed! Exit
Online Plotter?” GHENRETLE LT, A T4 0T uvX—%FLETNn?) tFNRDIV 4 RUBRERS
NET, bIDVPULERZHRELEZVWOT, [NolRZ %220 v 7 LET,

TRNSYS: C¥TRMSYS18demo¥MyProjects¥Test DEM OVERSION - ..

Calculations completed! Exit Online Plotter?

St

15.01 TRMNEYE Releaze 16.00.0013

17 ZE THEO Online Plotter ® H /7 &

BENROVBTRIRIRINTOHETN, HEEHOL L UYRKETEDLZ0OT, EtobH-0 %2270 v 7 LT
Maximum (o KfE) % 30 IZEE L, [OKIRZ %27V v LET, 2T, L DEEN A FIZ 30CiE<
EFCEATZEVOHBEMREE T 7 THMHBETEEL, BB, ZOFRL U VOREIL, H 52U, Type6se
DRT A=A THREL TR Z L TEEJ, Parameterd F H D7 Left Axis Maximum”73 Z O HICAHYS L
T, WA LEOX]IZZ Y v L, A TIArTry X —0liEEHE L ET,

&
Calculations  Plot Options  About
Temperature [C] Heat Tran

— Outlet — label
— label

Scale Axis

ZOB1UT §
oy |

800 1000 1200 1
Simulation Time = 24.|

18 Online Plotter ML 25 H

19



&. TRNEXE: C¥TRNSYS18demo*MyProjects¥Test¥ DEMOVERS 1O N - Test.dck

Calculations  Plot Options  About
Temperature [C]

— Outlet
— label

Heat Transfer Rate [kJ/h]
— label

30.00

24,00 [SEESE

-
co
[}
=}

—~
e
=}
S

______________

Temperature [C]

0.00

0.00 2.00 4.00 6.00 8.00 12.00 1400 16.00

1000
Simulation Time = 24.00 [hr]

-----------------------------------------------------------------

10000
.......... 8000
,,,,,,,,,, 6000
, ---------- 4000

serdanenans 2000

H H ; 0
18.00 20.00 2200 2400

Heat Transfer Rate [kJ/h]

19 Online Plotter O iilL > T 28 B 1% O[] [

Type65c iZ, 7F A N7 7 A VTHRREHNIITHDOT, SEIIELLEHBELET,

TaY=l N4y RUEHE T, Type6se DT A 2L &2 X707 U 7 L, FtEsk € Ol % FKor S %
¥, "External Files”# 7% 27 U v L, [EditlRZ %227 Vv 27 LET, B, Vo= FTROHEH D TT

DANBH 7740 77 A40) 1 X, A=a—"=D05
Calculate > Open > External files
ZIZEHZLETHSZLEBTEET,

TZTC AT AL [F¥plt | ERAFINTWVDDTREGREICENE TR, 77 A VAT 5 [F%)
DEI, [Ty "M ER—] EWHIEKRTT, 20, AL, Testtpf LWVWOIAHTT Y =7 M
RIFELIZTeD, TR A MAT—Z1E Testplt LWVI T 7 A NATHLZEEZERLTWET, NAZFFICHE
L722WGA . Test.plt (%, Test.tpf LRI LU 7 # VHIBRIFEESNET,

(DEMOWVERSION - Test.tpf) Type6Sec

Parameter Input  Special Card§_ External Files Xomment

1 What file should the online print m A
i @ D?Q e =hou e anline prin "kkp Browse . Edit.
Eif =)
20 LR —R NG T AN B R
20

%26

WHT77ALD FizhbHD
N, TalzIh~DANSTT
TANTHD, JLIRT A A

KRBT —5 () D774
LY,

X27

ITT— Ao —T DI A%

BETToWGEIT, FHEASE
T3 %m0, 77 A0
DYLIET 5T 74RO plt
MO IXUREICEH L TRE
F,



dy | Calculate | Tools Window 7

%[ Create input file l I]_|]T 1t [|_|:|l L:"E' =) 5.'

Run simulation Fa |

Parametric study
Open > Input file
List file

Result file

External files > les¥Weather Data¥Tokyo.99
. plt

21 A=z — = )7 7 A VAR

TIPS 21 OHSI77ANVDE EIZHEDH, ATIRDINHETZ 740V Thh, JLIRT A ARG T —4 () T
9, External files ®&ZAT, AT, M7 7 ANNCT 7 BATEXAZENDOOVET,

HAGEBREED PC TlE, 22T, 23D T7— &G T ¢« o FUNB ZENZNE 5 TR, - TIOK]
#2707 LTHUETLEIW (ZOFIENEEZGEIE. TORDT7 7 A NVOWEF 45T 7 40 RO plt 15
txt R ED—AIR B DIZEZ TEB LRWTL XL I),

BHEOI Vv D%, AERREDTIFAMET 4 X THAT —2RERINET, JFIERYIaLb—va
OB, ZHIALBENH D ZRE L-ZEHA O EEREEL TV ET,

| DEMOVERSION - Project.plt - ATEE - o x

TJrillF) |/EE SHO) FTN ALTH)

| TIME Out let |abel label ~
+).0000000000000000E+00 +2.0000000000000000E+01 +0.0000000000000D00E+00 +).00
+1..0000000000000000E+00 +1.8799288710976029E+01 +.0000000000000000E+00 +].00
+2.0000000000000000E+00 +1.8738512432929905E+01 +.0000000000000000E+00 +],00
+3.0000000000000000E+00 +1.8713538422720606E+01 +0.0000000000000000E+00 +1.00
+4. 0000000000000000E+00 +1.8672210070705092E+01 +. 0000000000000000E+00 +],00
+5_0000000000000000E+00 +1.8634530623267737E+1 +0.0000000000000D00E+00 +).00
+. 0000000000000000E+00 +1.8613768947249969E+01 +.0000000000000000E+00 +].00
+7.0000000000000000E+00 +1.6594340662666991E+01 +.0000000000000000E+00 +].00
+8.0000000000000000E+00 +1.9263523940366078E+01 +0.0000000000000000E+00 +1.00

22 W77 AN % AEHR TR

TIPS 774/ hORAETIL, Online Plotter =2 AR —R D )7 74V OYEIRT-1Z.plt T, Printer (Type25¢
708) AL R — R MOPERR T IT.out T A, ZTHHIEK 20 12779 External Files %7 O CH HIZAE TX
FI, ZITHETAREE, 207y =/, A7 7 AVBERICR2EE T, B0 7 —2& MLk
WDIZ, T7ANVRO**OEETIEFCH 7 7 A MCEE SN T, OB 7 — 227> TLE
WET JRIR TR —T 2 DB LD 177 A D3bHEEITIE, 247 External Files #7 TMSLLTZ 7 7 (/v 4
ERELTLIES N,

CHRTHIBOY AT ABNERLE L-, VA n"—0"Save R 22710 07 LT (Fi3 A =2 ——
® File>Save T), LEXREAFELTBEEL LI,

21



w
\'l
1

Alb—2a ALEFL EMENEE

TRNSYS (ZfR D EFHAN, 2 b—a UETIHBRICET TEALRVWOIX, SRS EFESRVWEEZD
i, Wbwwd [FAZ | AEETY, ZITEENMICRESGZREISE, T OMEEITVET,

FIEEER L7027 N T, 0V b4 RUCHD Type9d 74 a2 X TVr U w7 L,
External # 7% 7 U v 27 LT, JLRT A X AKRRT — X O EET AR RITET, [ET —X 77 A0EL
T. ¥Examples¥Weather Data¥Tokyo.99 2B L CWETHR, ZIZDRRLET 7 A L4 % TXT, HIFRLT
LEVWET, 7F AP ETOSLKD 207 Y v 7§25 LREATRERIRBICR 5 DT, F—AH— FD[Delete] —
X°[Backspacel ¥ —72 F &> T, 7FAMEHELTIZE,

WELEL, AEOIX]IZZY 7 LT 4 RUEALET,

(DEMOWVERSION - Test.tpf) Typeos-AMeDAS

Parameter Input Output Derivative SpeciaICard Comment

i g | = I B i Q )rowse | Edit.. |
o [m] o
-Er.
-
Typetd-AMeDAS
o o o

23 INTJELTRET =2 D7 7 AR ER KIESED

ZOWREET, FHHEAEFITLTLLZ I, F<IZ, "One error was found in the deck. Check the listing file for
more information!” (—~2DTT—BbV EF, VAT 7 A LERRBLTES) LI AyE—VDED
U4y RUREKRENDIFTTTT, OKIZ2Z Vv 7 LTI —RRFEH LTI ZEN,

TRMSYS ERRORS ot
Cne error was found in the deck.
Check the listing file for more information!

24 FIRETHRDOTT =Ry T

TIPS L&8Y, TRNSYS DAyt —12 the deck” W) BAFE DNV E G L 97, 2L ver.15 T GUI 2331 S5
PN HESN TV, THRAR—Z TR &7z TRNSYS HO7 a7 77 AV Thb, deck (T vF) 7
FANDYLETT, HEob, FuPxI 7 7 AN (tph e RIS E BTSN

KT PR ESNET 4 RUBRFRENDDT, T2 TR Error" R385 %5425 3 1THZ 27 U
v 7 (EDFTHHWEEA) L, HHITEHERERLET,

22



TRNSYS Message 350: Unable to open file associated with an ASSIGNED logical unit number.
Please check the ASSIGN statement and make sure that the file exists at the specified locati

(FIYTONTBEBE I Y T2 7 ANV E T EY o B TR LML, YD/ SRITT 7 AV
T FIAFAED I L TS WY

B Simulation log : c:¥trnsys18demo¥myprojects¥testfdemoversion - testlog

Messages

@ 2error(s) /B Dwarning(s) (i) 2 notice(s)

2 message(s) found {total: 4 message(s))

No| Sewerity | Time (h) | Unit | Type Message

3 |Ervor G000 ] 0 [TRRETS Mescage 3501 Unable 1o open The Al assoomted with o I\_-uNtUl GETCal IR number Flease check the
[ASSIGN statement and make sure the Hh ﬁl it tth spec ifed lacstio
Reported information : Logical Unit= 30, FileMame =

4 |Error [ ele] 2 0| Total Fatal Errors 1

X 25 URARNZ7A/NDTT— Ayt —UFKR

HHFEIISTRE, [HRTOEELETZ 7ANVERTEEAILE DN TWLZER NV ES, 77V %
B EERHLDIE, AT 7 AN (ZZTIERGET —2) i 7 7AONTNNTT DT, TATEHEE

%, ZNDIZEIR T 52 R —3k 1T External Files O > RGBT UL LN ER DD ET, UAR
TrANDIERING, SIFEETET | JRT —FD/RRET 7 AN A PNELSERESIL T VRN LR
TLXY,

TIPS =7 —n I CX7- [FHERE 5 &1, TRNSYS A3 H B &« DA77 A/VIZRRET S ID FH DT
LT G A=ZOFIZEENTHET (B2 1 Type99 Tik Parameter © 1% B ), = —FIXFREFZOL T I
TEETEAL, THULELDHVER A, SBE BT 7—X AL T 7 AV NEEE 70 FAELIR -
720, LW —ANFZEAETT,

TRNSYS i~ TW\5 &, BERNE, UART 7 A ANELDOART LR L WO T, Fatal Error <
FUBA LT = FHEEP T 7B ETICRES LT 2O T —ICHARWET, ZOHEIT ok
BRI 2T X7 ik, DF 0, arR—3x 2 bRV U7 EBOL L, FOaryR =3 PRELLHESRTE
D, EOarR—3xr hBREGORREIZZR>TWE0, ZEINCT =y 7 T5Z 8170 3, EHe AT

ZRRMIER DT E | AFRGE TN EDICFEZFT L, MRCH S HAZHER L RN OILEL TN 2 ER3E
G

REAE LTS, EICKRBEOA LV R—F 2 FEORNTNRTI A= EEZZRELTLE D X9 7R00 I8,
TuTxl MEROBEEENG, ZEDICELE THERFANRTEDLZLE2T v 7 T2 RITLNTEL X

90

23



FIFE, ANFHIBRLTCLE SRS T —4 %, b EDEFRBEREICRT O, FOTrY27 by
4V RTIZHD Type99 7 A 2 X TNV w7 L, External ¥ 7% 27 U v 7 LT, JRIET A X ARRT —X
OREMEZ TR SEET, 77 A NVABRHIBRENZEA L R8T OT SABKIZH S, "Browse..." R L & 7
Uy o doE 77ANEER - 45ET % Windows B FRSILET,

Z 2T, C¥TRNSYS18Demo (N7 4 7L 74 A XA FREICHELEZLDIZL T EEWN)
¥Examples¥Weather Data¥Tokyo.99 IZAHHY T 57 7 A VAR L THREZ LT IEI W,

4 ft8&: PATLZEIERLTHED

EOITHBZT > CHIENHT DD, ik & LTI b 28 E2 BB 2R LEd, LiTRkFLE
TuY =y ML OHRIEEZIT > THA TS IZSN,

4.1 EREOHEAZEM I aL—a 34 LATY TOHEN

Typela ® Output @ 3 F (HEEE) 7°5., Type65c @ Input © 3FE (F#ihz/R) 12, HAY 7 %130 £,

BT (DEMOVERSION - Test.tpf) Typela - > TypesSc O *
Clazzsic  Table
Select variable fiter : | Al v| @123 QOaz
& 2

Cutlet temperature ——————  Left axis vanable-1 Ctlet
Outlet flowrate Left axis variable-2 label

Useful energy @m axis varigble-1  Useful

Bight axis variable-2 label

(=] [X

%4

26 Typela OEE\EZ Type65c ~J 7

HHEMLD, A TALTuyFA—DLrPEUTOLERBOFHELTRBEET,
Type65c ® Parameter O 4 % (Z#oo FIRIE) % 50 12,
Type65c ® Parameter ® 6 #F (il EfR{E) % 10000 (2,
ENENERLET,

24



(DEMOVERSION - Test.tpf) Typessc

Input  Special Cards External Files Comment

& Mame Walue Unit More Macro
1 & MNb.ofleft—axis wariable s H Maore...
i 2 & Mb. of righ t—axiz variablas ? Mare ...
3 = Left axiz minimum oo More ..
4 s Left axis maxmum C 50 ) More ..
5 @ Rieht a:d= minimum L Morea ...
B | gp[Feht i masdmam “~[To000 ) Mare .
& Mumber of plotz per simulation 1 More ...
B s X -z gridpoints 1 More ...
E] & Shut off Online w/o removing o More ..
10 8 Logical Unit for output file 3 Mare ...

X 27 Ao T4 T ayd—DL TR TS

VIal—YarDFALAT YT E0.1hr ITEF L.

Settings

Basic Settings  Advanced Settings Project Component Order

, Simulation start time Calendar

o T

, Simulation stop time

24 |hr v| |Januar3.r v| IZ—VI
P E T

ik

T3lh Simulation time step

I |O.1 ) | |hr ~ More...

+oel

More...

More...

AT

X 28 ZALAT 7% 0.1hr ~ZH

25

AREETLET,




50.00 10000

40.00 8000 -
=
— 2
) ©
E 30.00 6000 E
£ =
S ko
£ g
= 20.00 4000 &
@ (S
= bt
m
I

10.00

2000

0.00 ' i j ' ‘ ' ' ‘ : : ‘ 0
000 200 400 600 800 1000 1200 1400 1600 1800 2000 2200 2400

29 EEBEDIBIMEX A LAT 7 HAHE LT s R
4.2 EHR2 TDEM
EEGR 7L LT, Direct Access 705,

Hydronics > Pumps >Single Speed > Typell4
ABRL, 7my=2 MZBEMLET,

%, Simulation Studio - [DEMOVERSION - Test.tpf]
°@" File Edit Wiew Direct Access Assembly Calculate Tools Window I

DesEd oo 57

(3 Controllers
3 Electical
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